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RESIZE MENUS
ON1 Photo RAW (MacOS Only)

• About ON1 Photo RAW: Opens the About box and displays 
your version number. (This is in the Help menu on Windows)

• Preferences: Opens the preferences dialog. (In the Edit menu 
on Windows)

• Quit ON1 Photo RAW: Quits ON1 Photo RAW 2020.

File Menu

• Done: Saves the current image and returns to Browse (or 
external source).

• Cancel: Cancels any Resize operations and returns to Browse 
(or external source).

• Quick Export: Saves the current image in Photoshop, TIFF, 
JPEG or PNG format

• Export: Calls up the Export pane.

• Print: Opens up the print dialog box.

• Manage Extras: Opens the Extras Manager window.

Edit Menu

• Undo: Removes the last file operation.

• Redo: Redoes the undo operation.

• Cut: Cuts the currently selected item.

• Copy: Copies the currently selected item.

• Paste: Pastes the items in the clipboard.

• Preferences (Windows): Opens the Preferences dialog.
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Settings Menu

• Reset all Settings: Resets any settings made in Resize.

• Reset Resize Settings: Resets any changes made in the 
Settings pane.

• Reset Crop: Resets the crop.

• Save Settings as Preset: Saves the current Resize settings as a 
preset.

• Update Preset with Current Settings: If an image with a 
preset applied has had some settings changed, this lets you 
update the preset to reflect those new settings.

• Rename Preset: Renames the current preset.

• Delete Preset: Deletes the currently selected preset.

• Export Preset: Exports the current preset as an .onresize file.

• Import Preset: Imports ON1 Resize preset files.

• Get More Presets: Opens ON1’s Presets page in your web 
browser.

View Menu

• Zoom In: Zooms the preview window in one increment. This 
will make the preview image larger.

• Zoom Out: Zooms the preview window out one increment. 
This will make the preview images smaller.

• Fit to Screen: This sets the preview image so that the entire 
image is on screen at once. Think of this as an overview of the 
entire image. This is the setting you will use most of the time.

• Actual Pixels: This sets the preview image so that it zooms to 
actual pixels or 1:1 also called 100%. This setting allows you 
to see every pixel in the image. This is useful when making 
precision adjustments.

• Show Clipping: Shows the clipping overlay view, displaying the 
pure white or black pixels in the current image.

• Preview Background Color: Lets you set the background color 
options.

• Enable Soft Proofing: Turns on soft proofing.

• Gamut warning: Displays colors that the printer can’t 
reproduce with a red overlay.

• Profiles: Displays a list of installed printer and display profiles; 
selecting a profile will apply soft proofing for that profile.

• Intent: Lets you switch between perceptual or relative 
rendering intent for the current image.

• Simulate Paper and Ink: When turned on, Photo RAW will set 
the white point and black point of the display to account for 
that of the chosen profile.
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Window

• Minimize: Minimizes your screen.

• Zoom: Zooms your window to full-size (doesn’t hide menu 
bar).

• Full Screen: Toggles to and from full-screen mode (hides menu 
bar).

• Navigator/Loupe/Histogram: Hides or shows the Navigator, 
Loupe, Histogram (Levels) and Info pane.

• Pixel Dimensions: Opens or closes the Pixel Dimensions pane.

• Document Size: Opens or closes the Document Size pane.

• Settings: Opens or closes the Settings pane.

• Sharpening: Opens or closes the Sharpening pane.

• Film Grain: Opens or closes the Film Grain pane.

• Tiling: Opens or closes the Tiling pane.

• Gallery Wrap: Opens or closes the Gallery Wrap pane.

• Solo Mode: When enabled, this feature keeps only one 
control pane open at a time.

• Show Control Panel: Hides or shows the Control Panel.

• Hide Panels: Hides or shows all Panels.

• Document Name: Shows the name, zoom level and bit depth 
of the open image.

Help

• Search: Searches the menu options (MacOS only).

• ON1 Photo RAW 2020 Online Help: Opens ON1.com support 
page in your default web browser.

• Video Tutorials: Opens ON1.com product training page in 
your default web browser.

• Getting Started: Opens the initial Photo RAW startup screens.

• Check for Updates: Checks with the ON1 update server to 
see if you are running the current version. If there is a newer 
version, you will be notified and be walked through the 
update process.

• Sign-In/Sign-Out: Uses your ON1 account login information 
to authenticate your copy of ON1 Photo RAW 2020.

• Provide Feedback: Opens the default web browser and goes 
to the feedback page of the ON1 website.

• About ON1 Photo RAW (Windows Only): Opens the about 
box with the version number displayed.

• Help Improve ON1 Products: Opens the Improve ON1 
Products dialog.

• Show ON1 Log: Diagnostic tool that can help ON1 support 
when you’re having issues with ON1 Photo RAW 2020.
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PREFERENCES
ON1 Photo RAW 2020 has a number of system-wide settings that you can set via the Preferences 
window. To access Preferences, either click on the gear icon at the lower left side of the screen, or choose 
Preferences from the ON1 Photo RAW 2020 menu (MacOS) or the Edit menu in Windows.

The Preferences window has five tabs: General, Files, Plug-Ins, System, Services. The settings in each tab 
are described below.

GENERAL SETTINGS

The General settings tab adjusts basic settings 
for the Photo RAW workspace, including 
background color, scrolling controls and more.

Scrolling Controls

Lets you select how the mouse scroll wheel or 
scrolling gesture works. The options are:

• None: Default.

• Preview Zoom: Adjusts the zoom of the 
preview window. Scrolling up increases 
the zoom, scrolling down decreases the zoom.

• Preview Pan: Pans the image, like using the pan tool or navigator. It is important that the panning is 
comfortable, not too fast or slow or jerky.

• Brush Size: Adjusts the size of the current tool if relevant, such as a brush tool.

Preview Background Color

You may select the color of the background behind the preview image. The default color is black. There is 
options for black, white, light gray, dark gray and custom. The custom option has a color picker where you 
can select your own background color.

Accent Color

Lets you choose the display color for highlighted items (folders, tabs, selections) in the Photo RAW 
interface.

Application Language

Lets you change the display language for ON1 Photo RAW 2020. Auto will use your system’s default 
language (if available).
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Check for Update on Launch

Enabled by default, the product will communicate with ON1’s software update server when you start ON1 
Photo; if an update is available it will prompt you to download or skip.

Default Browse Location

By default, the Pictures short cut in Browse is either Pictures (Mac) or My Pictures (Windows). You can 
change that location via this setting.

FILES

The Files tab is used to determine what file 
type ON1 Photo RAW will create when opening 
a file in Resize, as a plug-in from an external 
application, or when creating copies to send to 
an external editor from within Browse.

What to Edit

There are five options in the What to Edit 
section of the Files tab:

1.	 File Format: Sets the file type you wish 
to create: PSD, TIFF, or JPEG. If you wish 
to use a layered workflow, you must 
choose PSD.

2.	 Color Space: Sets the default color space when opening a copy of a file; the list includes Adobe RGB 
1998, Apple RGB (MacOS), sRGB, ProPhoto RGB, or ColorMatch RGB. (If you imported a profile for 
use in the General preferences, it will also be available here.)

3.	 Bit Depth: Sets the bit depth for the file when opening a copy of a file.

4.	 Resolution: Sets the resolution when opening a copy of a file.

5.	 Show these options every time: If you do not wish to use a predefined set of file characteristics for 
opening photos from Lightroom or Photoshop, click this box.

Sidecar Options

Click this box if you wish ON1 Photo RAW 2020 to create ON1-specific ‘sidecar’ files when you are editing 
images. This is helpful if you are using the same image library with multiple computers (on an external hard 
drive, for example), and want your edits to be visible on each machine. 

Apply Lens Correction Automatically

With this option on, ON1 Photo RAW will use the lens correction automatically on any raw photo when 
you view it in Detail, Filmstrip or Compare modes.
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Treat RAW+JPG Pairs as a Single Photo

If you shoot RAW+JPG, you can use this option to ‘stack’ both photos inside Browse. (RAW+JPG pairs are 
shown with a small icon in the lower left corner of the thumbnail.)

PLUG-INS

The Plug-Ins tab is specific to using Photo RAW 
as a plug-in for Photoshop or Lightroom, and lets 
you set up conditions when opening files from 
these apps.

Photoshop

• Apply Results to: When editing in 
Photoshop you can choose to have your 
effect added to a copy of your current 
layer or to the current layer. You can also 
choose to start with the last used settings 
when launching ON1 Photo.

Lightroom

As shown in the Working with Lightroom section above, this preference lets you choose the specific 
options for files opened via the Plug-In Extras menu in Lightroom:

• Save Photoshop Files As: Controls how Photoshop files opened from Lightroom are saved, as smart 
photos or regular PSDs.

• File Type: The file type drop-down menu determines what type of file will be created. The default is 
PSD, which maintains layers. You can also select JPG or TIFF if you prefer those formats and are not 
concerned about maintaining layers. The last option is same as source, which maintains the file type of 
the original file, except for Lightroom raw files, which are saved as PSDs.

• Color Space: Sets the working color space; Adobe RGB, sRGB or ProPhoto RGB.

• Bit Depth: Sets the file bit depth, either 8-bit or 16-bit per pixel.

• Resolution: The resolution drop-down menu determines the resolution of the file.

• Stack with Original: When enabled, the new image is stacked with the original image.

• Use Original for Single PSDs: When enabled, if you select a single PSD file, it will be edited directly, 
rather than having a copy made.
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SYSTEM

The System tab displays performance-related 
characteristics of Photo RAW 2020.

Memory Usage

• System Usage: Specifies the amount of 
RAM that is used by the application. The 
maximum (default value) is 80%.

• VRAM Usage: Specifies the amount of 
video memory (VRAM) that is used by the 
application. The maximum (default) is 80%.

Scratch Folder Location

This setting lets you move or reset your memory 
cache, which helps speed editing operations 
while you’re running Photo RAW. This is helpful 
if your system drive has limited space and wish 
to use a faster external drive as a cache. This 
cache information is purged each time you quit 
the application.

Browse Cache

ON1 Photo RAW 2020 stores thumbnails previews on disk so that the next time you browse a folder it 
loads much faster. This setting lets you adjust the memory cache size as well as empty the cache, move it to 
another location, or reset it if you are having issues with Browse. 

TIP: If you have a small solid-state drive as your boot volume, you should move 
your cache to another drive, since the Browse cache can take up a lot of space 
when you are using cataloged folders.

Performance

The Performance section is designed to help you optimize Photo RAW for your specific setup. The 
adjustments you can make are as follows:

• Video Card Strength balances updating the preview of the image and the movement of brushes and 
gradient tool overlays. If your brush is sticking try turning it down. If you have a high-end video card try 
turning it up for faster preview updating.
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• Fast Panning reduces the preview quality (makes it less sharp) while panning the photo to improve 
performance of panning.

• Fast Preview reduces the preview quality (makes it less sharp) while painting or making other 
adjustments to improve paintbrush performance. This is off if you have a high-end video card.

• GPU Render uses the GPU (video card) to render preset thumbnails, exporting, printing, sharing and 
caching. This can greatly improve performance. It is on by default for systems that support it. It may be 
disabled on lower-end GPUs.

Lightroom Migration Cache

If you run into problems with the Lightroom Migration Assistant, you can clear the cache here. (See 
“Moving Your Lightroom Catalog to Photo RAW” on page 14.)

SERVICES

This tab controls which online storage services 
are displayed in the Sources pane in Browse 
and Layers. Currently, ON1 Photo RAW 2020 
supports Dropbox, Google Drive, and Microsoft 
OneDrive. Photo RAW 2020 will automatically 
add any of the services if finds them on your 
computer during the installation process, but if 
you add (or remove) any of these services later, 
use this tab to manage them.
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Windows macOS
Change Modules/Tabs

Browse G

Develop D

Effects S

Portrait I

Local Adjustments A

Resize Y

Preview Nagivation

Zoom-in ⌃ + ⌘ +

Zoom-out ⌃ — ⌘ —

Fit to Screen ⌃ 0 ⌘ 0

Zoom to 100% (1:1) ⌃ ⎇ 0 ⌘ ⌥ 0

Pan Photo hold space

View & Window Modes

Grid View G

Photo View E

Filmstrip View F

Compare View (Browse) C

Fullscreen n/a ⌘ ⌃ F

Hide Right Panel ⌃→ ⌘ →

Hide Left Panel ⌃← ⌘  ←

Hide Both Panels ⇥

Split-Screen Compare (Develop/Effects) ⌃ Y ⌘ Y

Preview and Masking Views

Original View (Preview Off) \

Show Mask O

Show Clipping hold J

Enable Soft Proof ⎇ S ⌥ S

Browse

Change Thumbnail Size + /—

Browse a Folder ⌃ B ⌘ B

Select All ⌃ A ⌘ A

Select None ⌃ D ⌘ D

Deselect /

Set Rating 1-5

Set Label 6-0

Dislike X

Like P

Clear Like/Dislike U

Delete ⌦

Enable Filters ⌃ l ⌘ l

Search Text ⌃ F ⌘ F

Windows macOS
Presets

Open Quick View Browser ⎇ ↑ ⌥ ↑

Insert Preset ⎇ click ⌥ click

Photo Settings

Rotate 90 ⌃ ] ⌘ ]

Rotate -90 ⌃ [ ⌘ [

Reset All Settings ⇧ ⌃ R ⇧⌘ R

Copy Settings ⇧ ⌃ C ⇧⌘C

Paste Settings ⇧ ⌃ V ⇧⌘ V

Sync Settings ⇧ ⎇ S ⇧ ⌥ S

Create Version ⌃’ ⌘’

Brushing

Bigger Brush ]

Smaller Brush [

Increase Brush Opacity ⎇ ] ⌥ ]

Decrease Brush Opacity ⎇ [ ⌥ [

Increase Brush Feather ⇧ ]

Decrease Brush Feather ⇧ [

Set Brush Opacity ⎇ 1-0 ⌥ 1-0

Toggle Perfect Brush ⌃ R ⌘ R

Hold Perfect Brush Color hold ⌃ hold ⌘
Toggle Paint-in/Paint-out ⇧ X or hold ⎇/⌥
Invert Mask ⌃ i ⌘ i

Draw Straight Line ⇧ click

Misc

Quick Export ⇧ ⌃ S ⇧⌘ S

Print ⌃ P ⌘ P

Undo ⌃ Z ⌘ Z

Redo ⇧ ⌃ Z ⇧ ⌘ Z

Quit ⌃ Q ⌘ Q

Tools

Crop c

Adjustment Brush K

Adjustable Gradient ⇧ K
Perfect Eraser Q

Retouch Brush R

Clone Stamp S

Masking Brush B

Gradient Mask/Masking Bug M

Refine Mask N

Zoom/Pan Z

Move/Transform V

Text T

Portrait ⇧ I

Chisel H 

Blur L 

⌃ Control         ⌘  Command         ⎇  Alt       ⌥  Option        ⇧  Shift       ⇥  Tab

ON1 PHOTO RAW 
Common Keyboard Hotkeys
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